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media photography 1  Spring 2008 Dr. Tim Gleason 

 

Section A: MW 10:20am-12:30pm 

Section B: TR 12:40pm-2:50pm 
 
Office: 126A Clow, 424-7298; Email: gleason@uwosh.edu; 
www.uwosh.edu/d2l; Office: MW 9:10-10:10, 1:50-2:50; TR 8:00am-9am 
 
Description: This is both an introductory media photography class and an 
introductory photography class. I assume you enter this class with no 
photography experience. Do not expect to be an expert after one semester. Just 
enjoy your photography.  
 
Purpose: To learn the fundamentals of photography and to be able to complete 
basic media photo assignments.  
 
Equipment: You are required to have regular access to either a (1) SLR or 
rangefinder camera that has manual controls for focusing and making exposures. 
Cheap cameras are found on eBay; OR (2) some digital EVF cameras that allow 
similar controls. 
 
Grading: You will be held to the high standards applied to other journalism 
classes and introductory photography classes. My standards are based on my 
experience teaching at three universities in two different states, as well as being 
a former student of five different photo professors. Your grade will consist of 
assignments and in-class activities and quizzes. More specifically, your grade is 
made up of: 
 
 Five photo assignments at 100 points each  500 
 
 Final project        350 
 
 In-class/lab activities and quizzes   150 
 
 TOTAL       1000 
 
Attendance: Attendance/participation and timeliness is mandatory. I will take 
attendance every day. Activities will often be unannounced. The 20 percent of 
your grade for in class/lab includes your attendance and participation in class 
discussions and critiques. I reserve the right to not repeat information or offer 
material after it has already been offered in class or lab. Make-up opportunities 
for in-class activities or quizzes are generally not allowed. 
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Late Assignments: Assignments are due at the beginning of class on the day 
specified for each assignment. Any assignment not submitted at the stated time 
and day will be docked 10 points per class beginning with the class session it 
was due. Final projects are docked at 10 points per day on 24-hour cycles. 
 
Academic Honesty: Refer to the student handbook for more information. You 
must be aware of this information. Any work you submit must be your own 
creation. 
 
Source: UW Oshkosh Student Discipline Code 
 
UWS 14.03 Academic misconduct subject to disciplinary action. 
 
(1) Academic misconduct is an act in which a student: 
 
(a) Seeks to claim credit for the work or efforts of another without authorization or 
citation;  
 
(b) Uses unauthorized materials or fabricated data in any academic exercise; 
 
(c) Forges or falsifies academic documents or records; 
 
(d) Intentionally impedes or damages the academic work of others; 
 
(e) Engages in conduct aimed at making false representation of a student's 
academic performance; or student's academic performance; or 
 
(f) Assists other students in any of these acts.  
 
(2) Examples of academic misconduct include, but are not limited to: cheating on 
an examination; collaborating with others in work to be presented, contrary to the 
stated rules of the course; submitting a paper or assignment as one's own work 
when a part or all of the a paper or assignment as one's own work when a part or 
all of the paper or assignment is the work of another; submitting a paper or 
assignment that contains ideas or research of others without appropriately 
identifying the sources of those ideas; stealing examinations or course materials; 
submitting, if contrary to the rules of a course, work previously presented in 
another course; tampering with the laboratory experiment or computer program 
of another student; knowingly and intentionally assisting another student in any of 
the above, including assistance in an arrangement whereby any work, classroom 
performance, examination or other activity is submitted or performed by a person 
other than the student under whose name the work is submitted or performed. 
 

Assignments: Photography assignments will be graded using higher standards 
as the semester progresses. 
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Assignments are to be submitted inside an 11 x 14 inch (or close to that) 
envelope or in an expandable folder. Presentation is always important so don!t 
submit assignments in messy envelopes. Enclosed should be: 
 
 • your negatives or CD-R 
 • critique sheet with exposures in the boxes 
 • printed photographs with captions   
 • index prints or digital contact sheets 
 
Please have your name on the outside of the envelope. Note that photographs 
submitted of the local wildlife (squirrels, etc) are frowned upon. If the wildlife is 
acting like the killer rabbit in Monty Python!s The Holy Grail, then this might be 
acceptable. 
 
Assignments are based on John Szarkowski!s five characteristics of the 
photograph: the thing, the detail, the frame, time, and vantage point. 
 
Drop digital files of your images in the “Dropbox” in Desire2Learn. Each 
assignment has its own folder within the dropbox. The images should be 300 
resolution jpegs. You won!t be able to access these images after you drop them.  
 
The Thing: Portrait and Self-portrait 
 
Objective: To demonstrate you can operate the camera, scan and make digital 
prints, based on our lecture and lab activities.  
 
Submit two photographs. Make sure you use Kodak or Fuji color negative film in 
400 ISO only and use 24 or 36 exposures, if using a film camera. I would get 36 if 
I were you. 
 
#1) An environmental/personality portrait. This image should say something 
about the subject. Caption should identify person. 
 
#2) Self-portrait of yourself doing what you often do or that shows your 
personality. Include caption in third person form. 
 
Hints: Be careful about what shows in your backgrounds. Make the photos really 
show a personality. Avoid cliches. Do we need many more shots of students 
studying at computers?  
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The Frame 
 
Objective: To get you in the habit of looking at scenes in different ways. 
 
Photograph a scene in a horizontal format and a vertical format of the same 
subject to get two different photos. Scan and include caption in the file so it will 
print out. 
 
#1) Horizontal photograph from a horizontal negative/frame. 
 
#2) Same general scene, but take a vertical photo from a vertical negative/frame. 
 
Hints: The format you use should emphasize the inherent qualities of the subject. 
 
Time 

 
Objective: To demonstrate basic understanding of different shutter speeds and 
how they are used. Scan and include caption in the file so it will print out. Put 
shutter speed and f-stop in caption. 
 
Use a fast (high) shutter speed and a slow (low) shutter speed to your 
advantage. This can be of different subjects. 
 
#1) Fast shutter speed. 
 
#2) Slow shutter speed. 
 
Hints: The fast shutter speed should stop action. Use it so it is obvious. For 
example, if you stop a car on High or Algoma with a fast shutter speed, how do I 
know it really isn!t stopped? You will probably need to place your camera on 
something stable for the slow shutter speed photo. Remember to use the 
appropriate f-stop when changing shutter speeds, 
 
Vantage Point 
 
Objective: To demonstrate how scenes will look different from different 
perspectives. Scan and include caption in the file so it will print out. 
 
#1) Shoot a subject from a low angle.  
 
#2) Shoot the same or a different subject from a high angle.  
 
Hint: Hold onto your camera tightly when photographing from really high places. 
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The Detail 
 
Objective: To demonstrate you understand what depth of field is and how it 
affects detail; to demonstrate improved scanning and Photoshop skills. Put 
shutter speed and f-stop in caption. 
 
This assignment requires you to take the otherwise same photos using different f-
stops. By using widely different apertures you will have some images with 
noticeable backgrounds and others with blurry backgrounds. You must use the 
same lens for each photo. If you have a zoom lens, then you must use the same 
focal-length setting. Do NOT change your focus point. 
 
#1) Photograph a subject with the widest lens opening you can use, such as f2 or 
f4. Set your lens aperture to this widest setting and find the shutter speed that 
matches it. On a sunny day you might not be able to set your shutter speed to a 
number high enough to please your meter. In this case, adjust your aperture one 
stop at a time until you have a good exposure. 
 
#2) Photograph the same subject with a small f-stop like f22 or f16. This will be 
easy on a sunny day. If you don!t have much light then this will be hard. The 
reason is a small aperture doesn!t allow in much light and if there isn!t much 
available light, then you will need a slow shutter speed. Shutter speeds slower 
than 1/60 or 1/250 can cause blurring, so you might need to stabilize it. Set your 
lens aperture to the smallest setting and try to find a compatible shutter speed. If 
you can!t use a shutter speed fastest enough, then you may open up your 
aperture until you find a decent combination. 
 
Hints: The more the backgrounds differ in depth of field the better your grade. 
 
Final Project 
 
Objective: To demonstrate overall mastery and ability to cover a subject from 
various perspectives. 
 
I will accept proposals for color presentations from those who have subjects that 
merit color. You must have earned an A- or better on three of the previous 
assignments to be eligible for consideration. 
 
The form of presentation will be in PowerPoint (you will be given instructions on 
how to use this). You should aim to turn in 5-7 excellent photos of either a 
feature/news photo story/essay or an advertising campaign. 
 
Hints: You really do need to cover your subject more than once. Most people 
can!t do it on one visit. Don!t wait until the end of the semester to start on this. 
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Questions and Comments 
 
I pay attention to students! comments that are made to me directly or on 
evaluations. I like to share them with new students so they know what to expect. 
My goal is to get everyone up to the level that they could take any advanced 
photo class in the country. 
 
#1 How is the workload or difficulty? This is a journalism class and the 
expectations are similar to those of other journalism classes and art photography 
classes. This is NOT a blow-off class “just because it is photography.” 
 
#2 Why do I need this kind of camera? To really learn photography you need to 
use the proper tools. Without the camera, it would just be a digital imaging class. 
 
#3 Why are aesthetics important? Anyone can take a snapshot of their pet, just 
like anyone can write a letter to their grandmother. However, we are aiming to 
make pictures that other people will be interested in, like how you learn to write 
news stories that will interest many people. 
 
Supplies: This will be expensive, but I tried to keep costs down. 
 
First assignment will be on any film requiring process C-41 and has an ISO of 
400. You may choose other ISO film after the first assignment. Digital camera 
users should manually adjust their ISO. 
 
Can of compressed air, also known as canned air, if shooting film. This can often 
be found more cheaply at office supplies stores sold as canned air for computers. 
 
You probably want a jump or flash drive (USB drive) to store images. 
 
The text is the National Geographic: The Ultimate Field Guide to Photography. 
2006. 
 
Journalism Lab Disk Options 

 
There are several ways to save files in the labs, in order to have your files saved 
and saved correctly make sure you know the options. 
 
NOVELL ACCOUNT (highly recommended): The Novell accounts are space 
on the UW-Oshkosh sever that every student has available to them, links that 
connect you to the server are on the launcher, desktop or dock of every lab 
machine.  It is a free option that holds up to 75MB of data. 
Go to http://www.acs.uwosh.edu/novell/ for more information 
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Free service of UW-Oshkosh 
 
Warning: if you go over the 75mbs, the Novell server might corrupt your files 
when you save them. 
 
CD-R/RW: Lab machines in 128 and 148 are equipped with CD-RW drives.  If 
you place a blank CD into these machines it will show up as a normal disk that 
you can drag files to. Remember: disks are not “burned” until you try to eject 
them, depending on the size of the CD a disk can take as long as 15 minutes to 
finish burning. 
Disks cost about $5 for a 10 pack of CD-R, slightly more for CD-RW (read & 
write) 
 
 “Flash” Drives: Flash drives are a term for small, keychain sized drives that 
can plug into the USB ports on the Keyboards of any of the machines in the labs.  
They are a great option because unlike Zip disks they contain no moving parts 
and are very reliable.  Also they can connect to any computer that has a USB 
port, Mac or PC.  That way you won!t have to buy a zip drive to access your files 
at home.  Remember that like any other disk you have to drag it to the trash to 
“eject” it before you can remove the drive from the USB port.  
Cost from $30-80 depending on size, available online or at most department 
stores. 
 
Tentative Schedule 
 
Week 1 (2/4-5) -Introduction; film and exposure; discuss first assignment 

and final project 
 

(2/6-7) - Film and exposure; Camera basics; Read 6-43 
 
Week 2 (2/11-12)  -Digital camera basics; digital camera demonstration; Read 

44-95 
   

(2/12-13)  - Camera basics. Bring camera and roll of film. Also 
bring instructional manual and anything that might 
confuse you 

 
Week 3 (2/18-19) -Photoshop Basics; Read 210-251 
 

(2/20-21) -Scanning; bring your film sleeved, air and a removable 
disk if you use one to save photos. If using digital, bring 
digital images; Read 320-337 

  
Week 4 (2/25-26) -Digital imaging for your first project. 
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(2/27-28) -Finish digital imaging during first hour; Submit Asg1 

(portraits) for critique at beginning of second hour; 
discuss next assignment 

 
Week 5 (3/3-4) -Spot News and general news and captions; Read 118-153; 

open lab 
 
 (3/5-6)  -Features and captions; open lab 
 
Week 6 (3/10-11) -Digital imaging;  
 

(3/12-13) -Submit Asg 2 (Frame) after first hour; discuss next 
assignment  

 

Week 7 (3/17-18) - Sports, captions; open lab 
 

(3/19-20) - Portraits and captions. 
 
Week 8 (3/24-25) -SPRING BREAK 
 
 (3/26-27) - SPRING BREAK 

 
Week 9 (3/31-4/1) - Caption lecture and exercise; lab open afterwards 
 

(4/2-3) -Digital imaging for one hour; Submit Asg 3 (Time); discuss 
future assignments 

  
 
Week 10 (4/7-8) - Law and Ethical theories/practice 
 

(4/9-10) -Photo Essay examples and practice editing; Read 108-9 
 
Week 11 (4/14-15) -Advertising examples; digital imaging time 
   

(4/16-17) -- Open lab first hour; Submit Asg 4 (Vantage Point) as 
digital image for critique after first hour; discuss next 
project. 

 
Week 12 (4/21-22) --Photo Jeopardy 
 

(4/23-24) -- PowerPoint practice  
 
Week 13 (4/28-29) - Open lab 
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(4/30-5/1) - Submit Asg 5 (Detail) as digital image for critique after 

first hour 
  
Week 14 (5/5-8) - Work on final project all week 
   
Week 15 (5/12-13) -Final projects are due at end of session on Day 1 
 
 (5/14-15) -Day 2 is for critique 
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Scanner/Classroom Room Rules 
 
1. Don!t be a slob. We all have to use these spaces. Pick up after yourselves.  
 
2. Ask for advice. It is free. 
 
3. Don!t hit something that doesn!t work. 
 
4. Don!t store files on computer. 
 
5. Do not make degrading comments about the Buffalo Bills, pro soccer or my 
windowless office. 
 
6. No country music, hip hop or rap to be played in my presence. 
 
7. Share advice. 
 
Helpful hints! 
 
If you are confused about grading standards, then please ask me and I will be 
happy to explain. Or, if you are having any technical problems it is best to let me 
know as soon as possible. 
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Quick Reference Sheet 
 

Did you remember to? 
 

Resize (Image>Image Size; Resolution to 300) 
Sharpen* 
Tone (Image>Adjustments> Curves or Levels) 
Clone out dust or scratches 
Crop out distracting details 
Write caption in description of File>File Info 
Place thin rule around photo 
Use jpegs (quality 12) and drop files in Desire2Learn 

 
What are some of the things I cannot do? 
 

You cannot remove objects in your photos without permission. The 
removal of blemishes and reflections might be acceptable. 

 
What do I do differently for the final project? 
 
 “Photoshop” your high-resolution images. Make a copy of your images by  

File>Save As and rename your file. You now have two versions. Take the 
copy and change the resolution to 72 and make sure your image size is in 
the 6x9 or 8x10 range. Insert the 72 resolution images into Power Point. 

 
Submit the low res and high res images in Desire2Learn. Also submit the 
Power Point in Desire2Learn. 
 
You don!t need captions on your prints since they will be in Power Point. 
 
Submit prints of high res images and Power Point presentation. You can 
print all the slides on one sheet by going into the Print window and 
choosing Options and then Power Point. 

 
How do I make a digital contact sheet? 
 

Make digital contact sheets with images 4x5 (File>Automate>Contact 
Sheet II). 
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*According to Photoshop (the following is quoted material): 
 
 To use Unsharp Mask to sharpen an image: 

1  (Optional) If your image is multilayered, select the layer with the image you want 
sharpened. The Unsharp Mask can only be applied to one layer at a time, even if 
layers are linked or grouped. You can merge the layers before applying the Unsharp 
Mask filter. For more information on merging layers, see Merging and stamping layers. 

2  Choose Filter > Sharpen > Unsharp Mask. Make sure the Preview option is selected. 
 
Click the image in the preview window and hold down the mouse to see how the image 
looks without the sharpening. Drag in the preview window to see different parts of the 
image, and click + or - to zoom in or out. 
 
Although there is a preview window in the Unsharp Mask dialog box, it's best to move 
the dialog box so you can preview the effects of the filter in the document window. 
 
3  Drag the Radius slider or enter a value to determine the number of pixels surrounding 

the edge pixels that affect the sharpening. The greater the radius value, the wider the 
edge effects. And the wider the edge effects, the more obvious the sharpening. 

 
Adjusting the Radius value depends on the subject matter of the image, the size that the 
image will be reproduced at, and output method. For high-resolution images, a Radius 
between 1 and 2 is usually recommended. A lower value sharpens only the edge pixels, 
whereas a higher value sharpens a wider band of pixels. This effect is much less 
noticeable in print than on-screen, because a 2-pixel radius represents a smaller area in 
a high-resolution printed image. 
 
4  Do one of the following: 
•  Drag the Amount slider or enter a value to determine how much to increase the 

contrast of pixels. For high-resolution printed images, an amount between 150% and 
200% is usually recommended. 

•  Drag the Threshold slider or enter a value to determine how different the sharpened 
pixels must be from the surrounding area before they are considered edge pixels and 
sharpened by the filter. For instance, a threshold of 4 will affect all pixels that have 
tonal values that are different (on a scale of 0 to 255) by 4 or greater. So, if adjacent 
pixels have tonal values of 128 and 129, they will not be affected. To avoid introducing 
noise or posterization (in images with fleshtones, for example), use an edge mask or 
try experimenting with Threshold values between 2 and 20. The default Threshold 
value (0) sharpens all pixels in the image. For more information on using an edge 
mask for selective sharpening, see Selective sharpening. 

 
If applying Unsharp Mask makes already bright colors appear overly saturated, convert 
the image to Lab mode and apply the filter to the Lightness channel only. This sharpens 
the image without affecting the color components.
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Critique Sheet 
 
 
Name:      Assignment:   Grade: 
 
 
 
Place your camera settings for each frame in the proper box (such as 
125th@f5.6). 
 
1 2 3 4 5 6 

7 8 9 10 11 12 

13 14 15 16 17 18 

19 20 21 22 23 24 

25 26 27 28 29 30 

31 32 33 34 35 36 

 
 

Instructor!s Comments 
 
Excellent          Weak 
 

Film Exposure 
 

Film Sharpness 
 

Print Lightness/Darkness 
 

Print Contrast 
 

Print Sharpness 
 

Interest 
 

Aesthetics 
 

Met Requirements 
 

Dust, Scratches 


